
  
 

 

Images: Discovery, 
use and care 



 

2 

Software Used 
Windows 7 
Firefox, Internet Explorer, Chrome 
Adobe Bridge 
XnView 
PowerPoin 

Files Used 
HighResolution.tiff 
Flickr CC Images folder 
PhotoGalleryImages folder 

Revision Information 
Version Date Author Changes made 

2.0 October 2016 Dave Baker 
Clare Hills-Nova 

Rewrite 

2.0a January 2017 Dave Baker Rebranding 

    

    

Acknowledgements 
Thank you to Vicky Brown who helped formulate this workshop before moving on 
from Oxford. 

Copyright 
Dave Baker and Clare Hills-Nova make this document and the accompanying 
PowerPoint presentation available for reuse under a Creative Commons licence 
(Attribution-NonCommercial-ShareAlike CC BY-NC-SA) 

Where possible we have given attribution to images used in the presentation and 
exercises; these may be subject to their own conditions of reuse. 

The Oxford University logo is copyright of Oxford University and may only be used by 
Oxford University members in accordance with the University’s branding guidelines. 



 

3 

Contents 

Image Subscription Databases ............................................ 4 

Other Reliable Image Sources ............................................ 7 

Using Video ................................................................. 9 

Reverse Image Searching ................................................ 11 

Image Anatomy ............................................................ 12 

Resizing Images ............................................................ 14 

Viewing and Organising Image Metadata .............................. 17 

Backing Up Your Images .................................................. 19 

Citing and Captioning Images ........................................... 21 

Rights and Permissions ................................................... 22 

Lynda.com ................................................................. 26 

Your Notes ................................................................. 27 



 

4 

 Image Subscription Databases 
There are three key image subscription databases that the University has access to: 

• Archivision (art, architecture, archaeology)  
• Artstor (many subject areas, despite the name) 
• Bridgeman Education (many subject areas) 

They contain 2 million+ images of objects, locations, events, worldwide, from photo agencies, 
archives, libraries, museums, etc. 
Why should you use these in preference to other image sources? 

• Images in these databases have extremely useful associated information 
• Using these images for educational purposes (teaching and research) is legal 
• Image quality is guaranteed 

You may find that one database has more/better quality images but this will depend on the 
subject(s) you are researching. 

Task 
Find images 

• Open a browser, and go to SOLO (Oxford’s online catalogue): 
http://solo.bodleian.ox.ac.uk (or type solo bodleian in the Search box) 

• In the SOLO Search box, type one of the following database names 
• From the SOLO results list, click View Online below the database’s name  

o Archivision: No need to login or register 
o Artstor: You MUST register if you want to use the images you find (Register button is 

top right) 
o Bridgeman Education: No need to login or register. DO NOT TRY TO SEARCH the 

Bridgeman (as opposed to Bridgeman Education) database; this is not for educational 
use and we do not have access to it. 

Search all three databases to compare content  
• Use keyword(s) to search your own topic OR try searching a cultural icon (eg maria callas) 

OR a text (eg macbeth) OR a location (eg delhi) OR an event (eg french revolution) OR a 
concept (eg discrimination). 

View a larger image:  
• Double-click on a thumbnail 
• Zoom an image (Artstor and Bridgeman Education only): 

o Artstor: Click on “+” / “ –“ to ZOOM/zoom out (or use the  icon)  

o Bridgeman Education: Click on the eye symbol ( ) to ZOOM (or use “+” / “ –“ 
buttons) 

Compare image information 
• Archivision: From the opened image (not the thumbnail), select Go to Record 
• ARTstor and Bridgeman Education: Click on the text below the thumbnail. 
• Textual data can range from brief to extremely long and informative. Most data should 

provide: 
o Image ID number 
o Copyright holder. You cannot publish the image without first contacting the copyright 

holder. 

Save ONE image to your desktop or memory stick 
• Archivision: Right click on the image, then select Save Image As 

http://solo.bodleian.ox.ac.uk/
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• ARTstor: Double-click on the image, then click on the  icon & follow instructions. You 
must be logged on to do this. 

• Bridgeman Education: Click on the  icon below the thumbnail. Then click on the Save 
drop-down menu (bottom of the screen), then select Save As 

Save several images 
• Archivision: Not currently available 
• ARTstor: Save several images to an Image Group  

o Click on several thumbnails (borders will change colour)  
o Select the Organize tab  
o From the drop-down window, choose Save selected images to, then New image group  
o Save in My Work Folder and give the image group a name   

• Bridgeman Education: Save several images to a Slideshow  
o Click on the Select box below each thumbnail you want to save 
o Select Create slideshow (right), then From selected assets, then name your slideshow 
o If you want to make your Slideshow private:  

o Unclick the Make public box and type in your email address 
o Hit the Save button 

Download an image set 
• Archivision: Not currently available 
• ARTstor: 

o Select the Organize tab, then Open image group  
o Select Open My Work Folder, then the image group you are working with  
o Select the Tools tab  
o Select Export image group to PowerPoint 

• Bridgeman Education: 
o Select the relevant Slideshow, then Download. 

Your Slideshow will download as a PDF document. 

Further information 
Need more HELP? 

• Archivision: Select the Help button (top right): very detailed instructions 
• ARTstor: Use the Help button: very detailed instructions 
• Bridgeman Education: Select the Using the site tab 

Need more resources? 
Use Oxford’s documents and information resources relating to image research: 

• Open a browser and go to Oxford’s research guides (“libguides”): http://ox.libguides.com 
• Click on the Subjects A-Z icon, then select Art and Architecture 
• Select the Training tab for links to other sites and documents 
• Select the Images tab for other databases recommended by Oxford researchers 

Rights and Permissions Information for Images in Archivision, ARTstor and Bridgeman 
Education  
You do not need to request permission to use an image if:  

• it is for a presentation or a paper/ essay 
• you are NOT planning to publish it 

http://ox.libguides.com/
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Other Reliable Image Sources 
How do you know an image is what its textual data claims it to be? 

• A Google search will not always produce a high quality and accurately attributed image.  
How can I find what I want? 

• We use text to describe images. Usually, you can only find an image if it has been tagged 
with the search term(s) you are using in your search.  

How can I be sure to find relevant images? 
• You may be better off targeting specialist sites and image providers. Three such resources 

are: 
o Flickr (a photo-sharing site) 
o Wellcome Images (medical images) 
o NYPL Digital Collections (images in the public domain or with no known copyright) 

Task 
Search for an image in Flickr, Wellcome Images, and NYPL Digital Collections. 
Note: you do not need to create accounts to search these resources. 

• Open three web browser tabs:  
o Flickr: http://flickr.com: Search for aspirin 
o Wellcome Images: http://wellcomeimages.org/: Search for aspirin 
o NYPL Digital Collections: http://digitalcollections.nypl.org/ : Search for aspirin 

• Select an image and examine the corresponding information 
o Flickr 

o On the search results page, select an image 
o View information: Scroll down to view photographer’s details, image rights, and 

some data about the photograph (EXIF data). 
o View other images by the same photographer: Click on photographer’s name 

o Wellcome  
o On the search results page, select an image 
o Scroll down to view the image details, credits and the copyright notice 

o NYPL  
o  On the search results page, select the image 
o  View further information: Select More detai ls   

Download an image and obtain the image URL for sharing 
• Flickr:  

o On the search results page, select an image 

o Select  (lower right hand side of the image) 
Note:  Some images ask you to create/sign into a Flickr account (using Yahoo) before 
you can download. 

o Select  (lower right hand side of the image) 
o Highlight the URL, then press Ctrl+C to copy the link 

Note: You can share the image via Facebook, Tumblr, Twitter, Pinterest 
• Wellcome Images:  

o On the search results page, select an image 
o EITHER Download a low-res image; OR Email; OR Print; OR Download hi-res image OR 

Add to Lightbox 
Note: You may find an image designated as a Rights-managed image. If you want to 
download the high-res version of one of these images, you will be need to negotiate a 

http://wellcomeimages.org/
http://digitalcollections.nypl.org/
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fee + terms of use with the Wellcome Library. (You’ll still be able to download the low-
res version.) 

• NYPL Digital Collections:  
o On the search results page, select an image  
o Below the image (right hand side), hover over the box next to the PERMALINK and Click 

to copy. 
(If necessary: In the pop-up box, select Allow now.) 

o View the Download options. (You can also order a high-resolution file if you wish.) 
o Select the 760px image and follow your browser’s instructions to open or save the 

image. Save the image to your desktop. 

Further reliable image sources 
• Museums/galleries/museums/libraries/archives 

o Usually best to go direct to source 
o Many will allow downloading of low resolution images for private study and often 

teaching 
o If you want to publish an image from a museum, etc.: 

o Always refer to the institution’s Terms and Conditions (“T’s & C’s”) to be sure what 
you can and what you cannot do with downloaded content 

o Some may re-direct you to a third party.  
o Some may allow you to download higher resolution images for academic publishing 

(“IAP”), e.g.: the Metropolitan Museum of Art (New York); the Getty Research 
Institute (Los Angeles) via its Open Content Program [this is NOT the same as Getty 
Images]; the British Museum. ARTstor includes IAP images 

• Use Oxford information resources relating to image research 
o Open a browser and go to Oxford’s research guides (“libguides”): 

http://ox.libguides.com 
o Click on the Subjects A-Z icon, then select Art and Architecture 
o Select the Training tab for links to other sites and documents 

• OR Select the Images tab for other image databases recommended by Oxford researchers 
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Using Video 
Video resources are becoming much more accessible. Not only are there resources such as 
YouTube and Vimeo where videos can be shared, but the technology needed to create your own 
videos is readily available and becoming easy to use. 
Generally, people want to show a 2-3 minute video in a presentation, indeed sometimes capture 
only a single frame. 
Most people want to incorporate a video in a PowerPoint presentation, but there are other video 
capture features in tools such as SnagIt, Windows Movie Maker and iMovie. 

Task 
Embed a video link into a presentation 

• Open PowerPoint and create a new presentation 
In the Home tab of the ribbon, select New Slide, then Layout, then Blank  

• Open a browser and go to YouTube: www.youtube.com 
• In YouTube’s search box, type piranesi carceri cini 
• Select the version uploaded by the Fondazione Giorgio Cini video (also with the highest 

number of hits - 20-30,000 – should come at the top of your results list) 
• Below the video, click Share, then (below) Embed 
• Copy the Embed code in the box below  
• Select PowerPoint’s Insert tab, then Video, then Online video (or Video from Web Site) 
• Paste the Embed code into the Video Embed Code box that appears on the slide 
• Press F5 to display the slide, click on the video box, click Watch on YouTube to run video 

Embed a video into a presentation 
• Open PowerPoint and create a new presentation 

In the Home tab of the ribbon, select New Slide, then Layout, then Blank  
• In the Insert tab of the ribbon, select Video | Video on my PC (or Video from File) 
• Select a video you’ve saved previously, then click Insert 
• Press F5 to display the slide, and click on the video to play it 

Trim an embedded video 
• In PowerPoint select/create your presentation  
• Click on the video you’ve embedded to select it 
• In the Playback tab, select Trim Video  
• Drag the green and red (Start and Finish) sliders to define an extract of the video, then 

click OK 
• Press F5 to display the slide, and click on the video to play it 
• In Normal view, on the video frame, press Play. 
• Select the video on the slide. 
• Under Video Tools, on the Playback tab, in the Editing group, click Trim Video. 
• In the Trim Video dialog box, do one or more of the following: 

o To trim the beginning of the clip, click the start point (shown in the image below as a 
green marker, on the far left). When you see the two-headed arrow, drag the arrow to 
the desired starting position for the video.  

o To trim the end of the clip, click the end point (shown in the image below as a red 
marker, on the right). When you see the two-headed arrow, drag the arrow to the 
desired ending position for the video.  

http://www.youtube.com/
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Capture a still from a video 
• In PowerPoint select/create your presentation 

In the Home tab of the ribbon, select New Slide, then Layout, then Blank. 
• Minimise PowerPoint. 
• Open a browser and go to http://www.youtube.com or http://vimeo.com. 
• Select a video and play it. 
• Pause the video at a point of your choosing (lower left-hand button). 
• Use Alt+Tab button to return to PowerPoint. 
• In the Insert tab of the ribbon, click on Screenshot, then select Screen Clipping. The 

browser window (with your paused video) will reappear, and the cursor changes to a 
crosshair. 

• Click and drag the crosshair over the area of the video that you want to capture. 
PowerPoint will automatically grab the area and insert it into the slide. 

Further Information 
Video formats 
There are a number of different video formats commonly used and most of these formats are 
supported by most video-enabled applications. 
The formats that you will encounter most often are: 

• AVI: one of the oldest formats and widely supported. 
• MP4 (MPEG-4): the most widely supported format. 
• FLV: these are produced by the Adobe Flash software. This format is very popular, 

especially for video delivered on the web. A major drawback is that FLV files are not 
supported on Apple mobile devices running iOS. 

• WMV: This is a Microsoft format, and so widely supported in Microsoft (Windows) 
applications, but less so on Mac and Linux platforms. 

Potential problems 
Video files usually have 3 parts: the video encoded in a particular format (often called a codec); 
the audio encoded in its own format; a container that holds the video and audio components, 
information to synchronise the two together, subtitles and metadata such as title, author, etc. 
PowerPoint (and other applications) rely on the correct software being installed on the computer 
in order to playback the video and audio codecs contained in the video container. The fact that 
a video plays back in PowerPoint on your computer does not guarantee it will playback on 
another computer. Always check ahead of time! 
As a backup, you should have a copy of your video(s) that you can play independently of 
PowerPoint. Most computers have a video application that you can use to open the video. 
Videos can be very large; when they are embedded into a presentation, the presentation file 
becomes very large too; you may not be able to email such a large file. In this case use a file 
transfer utility such as OxFile or DropBox. 
Some versions of PowerPoint do not embed an inserted video into the presentation – it links to 
the video file in whatever folder holds it. If that folder isn’t available when the video tries to 
play, it will fail. If using a different computer for the presentation, always check ahead of time! 
If you have inserted a web hosted video (e.g. YouTube video) into the presentation, you are 
relying on: 

• A live internet connection 
• The video still being available 

One or other of these may not hold true at the time of your presentation. Check ahead of time! 

Copyright 
The rules of copyright are more stringent for videos than images. You should seek advice from 
your librarian. 

http://www.youtube.com/
http://vimeo.com/
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Reverse Image Searching 
Most image searching involves entering text. If a potentially relevant image has not been tagged 
with the keyword term/s you’ve used to search, that vital hit will not appear in your results list.  
However, you can use an image to find an image. Try this when: 

• You have an image but don’t know what it is, or where it came from 
• You need a better quality/higher res version 
• You are hoping for a rights free version 

TinEye Reverse Image Search professes to search billions of images for a match. You may get 
lucky. 

Task 
Match your image 

• Open a browser, then go to TinEye Reverse Image Search: http://tineye.com/ 
• In the Search box you will see Upload or Enter Image URL 

• Next to the search box (left), click on  
• On the desktop, go to the  folder for this training session, then select TinEyeExample.jpg 
• From the drop-down Sort by box, select Best match 

 

Find out about the image content 
• Click on the Page link next to the image.  

 

Can you answer the following? 
• Q: What’s in the image? 

A: 
 

• Q: Where is it? 
A: 
 

• Q: Who designed it? 
A: 
 

• Q: Who owns the rights? 
A: 
 

https://www.tineye.com/
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Image Anatomy 
There are many different formats in which an image can be saved. Each format has its strengths 
and weaknesses. For bitmap images (i.e. composed of ‘pixels’), formats fall into two categories: 
lossless and lossy. Lossless formats preserve all the information, but take more file space. Lossy 
formats can be very compact, but at the expense of a loss of detail. 
Research images are best kept in a lossless format such as TIF. A copy of an image can always be 
converted into a lossy format such as JPEG when you need a more compact version, perhaps for 
a web page or for emailing to a colleague. 
In this task you will convert a TIF (aka TIFF) image to a JPEG at different compression settings. 

Task 
Open XnView MP 

• Start XnView  from the XnView MP shortcut.  

• Maximise the XnView window. 
• In the Folders  panel at the left of the XnView window, browse to the folder containing 

the session files. 

Examine the original image 
• Use View | View As | Thumbnails + Labels to show the image thumbnails.  
• Single click on the image of the bronze horse’s head to select it.  
• In the Info panel (bottom left), note the format is TIFF and the size is about 19MB. 
• Double-click on the image in the Preview panel to the right of the Info  panel. 
• Use View | Zoom | 1600% to clearly see the pixels in the image. 
• Close the Preview tab to return to the Browser tab 

Export the image in a JPEG format 
• Use Tools | Export to display the Export  dialog. 
• By default the JPEG export option is shown. Put a tick in the Auto refresh tick box. 
• Drag the Quality slider along the scale and notice the change in file size between the best 

and the lowest quality. 
• Use the Zoom button to zoom in and compare the original (left) with the preview. 
• At what quality setting can you discern differences between the original and the preview? 
• Set the Quality slider to 80 and click Export. Give the file the name Quality80. 
• Select the original, and repeat the Export, but this time use a Quality setting of 5, using a 

file name of Quality5. 
• Compare the file sizes and ‘look’ of the images by double-clicking on them. 

Close the program 
• Use File | Quit to close XnView. 

Answer the following question: 
• Why would you want to save a TIFF image as a low quality JPEG image? 

Further Information 
Images and pixels 
A digital image is a series of dots arranged in a regular grid. We refer to these dots as pixels 
(picture elements). Each pixel has a colour value and is of a size such that from a viewing 
distance they merge together to form an image. 
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Pixels on a monitor screen are fractions of a millimetre in size. Printed image pixels can be 
much smaller than that, and pixels for large displays, at (say) a sports stadium, can be 
centimetres in size. 
The more pixels we have, the more we are able to represent fine detail. Images can range in 
size from a few hundred pixels wide and high, to several thousand pixels on a side. Even modest 
digital cameras can produce image sizes of something like 2560 pixels x 1920 pixels, giving a 
total number of pixels of  
2560 x 1920 = 6,635,520. 
Image sizes are usually measured in millions of pixels, or megapixels, i.e. 6.6 MP. 
Digital image file sizes are large, and compression is used to reduce the size. 

Images and colour 
Pixels have colour, and colours are represented by numbers. In black and white images the 
number is 0 (black) or 1 (white); for greyscale images, grey tones from 0 (black) to 255 (white). 
Colour images are more complex. On screen colours are represented by amounts of Red, Green 
and Blue (RGB) and need 3 numbers per pixel. In print, colours are a mix of Cyan, Magenta, 
Yellow and Black (CMYK) and need 4 numbers. 

Compression 
With images being composed of millions of pixels, and each pixel requiring 3 or 4 numbers to 
represent it, image files can consume a lot of storage space. To alleviate this, we often 
compress images. There are many compression techniques (and hence many image ‘formats’), 
and some are mathematically complex. There are two broad categories: lossless and lossy. A 
lossless format preserves all of the detail in the original, whereas a lossy format is a compromise 
between file size and detail – the larger the file size, the greater the detail preserved. With a 
careful compromise, the amount of detail lost in an image saved in a lossy format is 
indiscernible to the human eye, even for substantial savings of file space. However that detail 
can never be recovered so you need to be careful when using lossy formats for your research 
images. 
Examples of lossless formats are: 

• Tagged Image Format .TIF or .TIFF 
• Adobe Photoshop .PSD 
• GIMP eXperimental Computing Facility .XCF 
• Portable Network Graphics .PNG 
• Windows BMP file format .BMP 
• Graphics Interchange Format .GIF 

And lossy formats: 
• Joint Photographic Experts Group .JPG or .JPEG 
• Google’s WebP .WEBP (which can also be used in a lossless mode) 

Vector images 
Illustrations and drawings can be represented in a vector format; rather than using pixels, the 
lines in the image are represented by descriptions of how they should be drawn. For example a 
circle of a particular radius and position with a particular line thickness of a particular colour for 
the line and fill. 
Typical vector formats are: 

• Scalable Vector Graphics .SVG 
• Adobe Illustrator .AI 
• Windows Metafile .WMF 
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Resizing Images 
Vector images (more accurately, vector diagrams and illustrations) are composed of lines and 
shapes that can be resized as needed without loss of definition. The file size of the image 
remains constant no matter how the image is sized on the screen. 
Most images you will work with are bitmap images. Bitmap images are composed of pixels, with 
each pixel taking some file space – the more pixels, the better the definition of the image, but 
the larger the file size. It is therefore important to optimise these images so that the number of 
pixels is appropriate for the use to which we will put the image. When we use images on screen, 
perhaps in a blog post, we can generally get away with far fewer pixels than when the same 
image needs to be printed at high quality. 
It is generally much better to control the number of pixels (the image ‘size’) yourself, rather 
than relying on an application to ‘optimise’ your image for you. 
You need to take care when resizing bitmap images within applications such as Word and 
PowerPoint. Reducing the size of an image is generally more successful than making it larger. 
However, when an image is reduced in size and the document saved, the application will often 
‘optimise’ the image to reduce the file size. If you then try to enlarge the image, the detail will 
have been reduced. 
Always keep a copy of the original of an image! 
In this task you will explore the effect of reducing, saving and then enlarging an image in Word. 

Task 
Insert an image into a Word document 

• Open Word 
• Create a new, blank document. 
• Use Insert | Picture and select the HorseBronze image from the session file folder. 

This is a bitmap image (as a TIFF format) which has enough pixels (and hence detail) to fill 
the width of the page at high quality. TIFF is a lossless format, which explains the large 
image file size (18.9MB). See the Image Anatomy task for information about image formats 
and compression. 

Save the document and examine its properties 
• Use File | Save to save the document with the name original.docx.  
• Use File | Info to examine the properties of the document. In particular look at the Size of 

the document. It should be about 3.5 MB. Can you explain where the other 15.4 MB has 
gone? 

• Click on Close to close the document. 

Reduce the image size and resave the document 
• Re-open the original.docx document 
• Click on the image to select it. 
• In the Format tab of the Ribbon, in the Size group, change the Height to 2cm. The width 

will also change. 
• Use File | Save As to save the document with the name reduced.docx.  
• Use File | Info to examine the properties of the document. In particular look at the S ize 

of the document. It should be about 130 KB. Can you explain this? 
• Click on Close to close the document. 

Enlarge the image and resave the document 
• Re-open the reduced.docx document 
• Click on the image to select it. 
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• In the Format tab of the Ribbon, in the Size group, change the Height back to 12cm. The 
width will also change. 

• Notice the degradation of the detail in the image. Why has this happened? 
• Use File | Save As to save the document with the name enlarged.docx. The file size 

should be about 130 KB. Why has this number not changed from the ‘reduced’ file? 
• Click on Close to close the document. 

Further Information 
Images and pixels 
A digital image is a series of dots arranged in a regular grid. We refer to these dots as pixels 
(picture elements). Each pixel has a colour value and is of a size such that from a viewing 
distance they merge together to form an image. 
Pixels on a monitor screen are fractions of a millimetre in size. Printed image pixels can be 
much smaller than that, and pixels for large displays, at say a sports stadium, can be 
centimetres in size. 
The more pixels we have, the more we are able to represent fine detail. Images can range in 
size from a few hundred pixels wide and high, to several thousand pixels on a side. Even modest 
digital cameras can produce image sizes of something like 2560 pixels x 1920 pixels, giving a 
total number of pixels of 2560 x 1920 = 6,635,520. 
Image sizes are usually measured in millions of pixels, or megapixels, i.e. 6.6 MP. 

Displaying images at their natural size 
When images are displayed, either on screen or printed on paper, we can think of the display 
space (all or part of the screen or paper) being an invisible grid, with each cell of the grid able 
to accept a pixel. The physical size of the grid cell (and the pixel) will depend on the properties 
of the screen or the print dot size of the printer. 
If the number of pixels in the image is less than or equal to the number of display cells 
available, then all of the image detail can be preserved in the displayed/printed image. 

Displaying images at a smaller size 
If the display space we make available to the image is reduced (often described as making the 
image smaller), then we may have too few display cells to accommodate all of the image pixels. 
We can only have one pixel per cell, so the application either throws away some of the pixels, or 
more likely ‘averages’ some pixels into a single pixel. In either case, image detail is lost. 

Displaying images at a larger size 
If we want an image to fill a display space that has more grid cells than there are pixels, the 
application needs to fill the empty grid cells. Usually this is done by ‘interpolating’: looking at 
occupied grid cells around an empty cell and making up a pixel that is similar in colour and/or 
brightness to the surrounding pixels. 
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Viewing and Organising Image Metadata 
Many image formats include metadata – information about the image itself. Usually this is 
technical data such as the equipment used to capture the image, or the time and date. 
Some formats allow you, as the image curator, to add additional metadata about the content. 
This might include location, names of people, subject matter, or other ‘tags’ that you can use to 
catalogue and search your image collection. 
There are a number of tools that give you access to image metadata. These include XnView MP, 
a free application for Windows and Mac OSX; and Adobe Bridge, a free application by Adobe. 

Task 
XnView MP 

• Start XnView  from the XnView MP folder.  

• Maximise the XnView window. 
• In the Folders  panel at the left of the XnView window, browse to the folder containing 

the session files, OR select any image/s that you have saved previously. 
• Examine the metadata for some images 

o Use View | View As | Thumbnails & Labels to show the image thumbnails with some of 
their metadata.  

o Single-click on an image to select it. (Image appears in lower panel of the screen, in 
Preview mode.) 

o The Info panel (bottom left of the XnView window) and Preview panel (bottom right) 
will be updated. 

o In the Info panel, click on the Properties and the ExifTool tabs to investigate the kind 
of information for the image. 

o The ExifTool information can sometimes take a while to update itself. Some image 
types have little or no Exif data. 

o The Categories tab will show boxes listing image contents type. Select the boxes 
relevant to your image. 

• Examine some other images as above. 
• Use File | Quit to close XnView. 

Adobe Bridge 
• Start Adobe Bridge from the Adobe Bridge folder. 
• Maximise the Adobe Bridge window. 
• In the Folders panel at the left of the Adobe Bridge window, browse to the folder 

containing the session files, OR select any image/s that you have saved previously. 
• Examine and edit the metadata for some images. 

o Use View | As Thumbnails to show the image thumbnails with some of the metadata.  
o Single click on an image to select it. (Image appears in the Preview panel, right-hand 

side of the window.) 
o In the Preview panel select the dropdown arrows next to IPTC core  and the Camera 

Data (Exif). View tagging options available. 
o Some image types have little or no IPTC or Exif data. 

• Add relevant data, for example to the Creator or Keyword fields; you will be prompted to 
Apply  your updates to the metadata. 

• In the Search box (top right) enter a tag term you applied to your image/s; the image(s) 
with this tag in the metadata will appear in the Contents panel. 

• Use File | Exit to close Adobe Bridge. 
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Further Information 
Exif. Some popular image formats, such as JPEG, TIFF, DNG and (most) RAW, allow for 
additional information to be embedded within the image file, so that information will travel 
with the image. This is usually referred to as metadata (information about the image 
information). The Exchange Image File format (Exif) is a standard method of doing this. 
Exif information can be very useful when looking back at images to check the camera 
parameters and time and date, but it does not include information about the image content. 
The Exif standard can be used and interpreted differently by different camera and software 
manufacturers. This sometimes leads to difficulties, particularly if an image undergoes 
processing in several different software applications. 
Most image management programmes allow you to examine the Exif data for an image; some 
allow you to change it. Exif information is also available through some file management utilities 
such as Windows Explorer and Mac Finder. Some software enables you to edit Exif data and 
include your own (limited) information. 
There are other metadata formats. Two of note are: 

• IPTC Information Interchange Model. Originally developed for use by news organisations, 
it has also been widely adopted by photographers, including those working in museums and 
galleries, as well as some stock photo agencies. 

• XMP. An XML-based standard developed by Adobe and which incorporates much of the IPTC 
standard. 

Managing image metadata across different software packages.  
Not all image editing software is able to manage all metadata formats. Hence it can be difficult 
to rely on metadata if the image is likely to be processed by different software packages. Also, 
some programmes strip embedded metadata from the image at point of ingest. 

Image metadata convertors and editors 
XnView MP. An excellent cross platform image converter and editor available from: 
www.xnview.com/en/xnviewmp/ 
Reveal. Available for both Windows and Mac OSX. Reveal is a single purpose utility; it only 
allows viewing and editing of image metadata and has some limitations but it is nonetheless 
useful. Available from 

• Windows version: www.albumshaper.sourceforge.net/ 
• Mac OSX version: www.macupdate.com/info.php/id/19758 

Adobe Bridge. Another widely used tool, Adobe Bridge uses the XMP standard (see above). It is 
part of the Adobe Creative Cloud Suite of software, but it can also be downloaded for free from 
the Adobe website. Using Adobe Bridge without other (paid for) Adobe software does restrict 
some of its functionality. 
You can find out more about embedded metadata, including a panel plug-in that can be 
incorporated for free into Adobe Bridge, from: http://metadatadeluxe.pbworks.com/ . 
Windows Explorer. Also allows for the viewing of limited amounts of image metadata. 

http://www.albumshaper.sourceforge.net/
http://www.macupdate.com/info.php/id/19758
http://metadatadeluxe.pbworks.com/
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Backing Up Your Images 
There is a difference between a backup of your image collection and an archive. 
A backup is an up-to-date copy of the collection, available in case of loss or corruption of all or 
part of that collection. An archive is a copy of the image collection held in a location and in a 
format that will enable the collection to be accessed sometime in the future, perhaps many 
years hence. 

Task 
Write down your plan for managing your research and other University related images: 
 
 
 
 
 
 
 
 
 
Write down your plan for managing your personal (home) images 
 
 
 
 
 
 
 
 
 
If necessary, discuss your plan with the course teacher 
 
 
 

Further Information 
Backup of your image collections 
Many professional photographers adhere to a 3-2-1 rule – three copies (an original and two 
backups) of every image, on at least two different media, at least one of which is off-site. You 
should take a similar approach. 
There are many possible ways this regime can be implemented, but a common one is: 

• Your collection is held on your hard drive 
• A backup copy of your collection is held on an external hard drive 
• A second backup copy of your collection is held ‘in the cloud’ 

In this example, we have three different media (internal hard drive, external hard drive, cloud). 
The cloud is our off-site copy, although the external hard drive might also be stored in another 
location when not in use. 
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The ‘cloud’ represents any storage accessed by an internet connection. This could be a 
departmental network drive, the University’s TSM backup facility, or perhaps a commercial 
solution such as DropBox. 
There are many ‘synchronisation’ applications that enable you to keep the three copies the 
same. You will need to be disciplined in routinely using one. 

An image ingestion workflow 
Allied to a robust backup regime is having a consistent workflow for your image management. 
Your workflow will depend on your research needs. A typical workflow is: 
 

 
 

Archive of your image collection 
Archive copies of your image collections also need to be backed up, but that operation is likely 
handled by whomever manages the archive (although that could be you!). 
An important aspect of an archive is the longevity of the format of the data and the media it is 
held on. If, for example, images are written to Blu-Ray disk, will Blu-Ray disk readers be 
available in 10 years’ time? If images are in a TIFF format, will there be applications available 
that can TIFF images? 
These are questions that tax professional archivists, and if it is critical that your images are 
accessible in the future, you should seek advice, in the first instance from your librarian. 
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Citing and Captioning Images 
No single specific style for image citation and captioning exists. Guidelines are available from: 

• Citation style guides, e.g.: Chicago Manual of Style 
• Professional organisations, e.g.: College Art Association (CAA) and the Modern Languages 

Association (MLA) 
• Journals/publishers, e.g.: Art Bulletin (published by CAA) 

Task 
Caption an image 

• Select an image you’ve previously found 
• Go to the Rhode Island School of Design (RISD) Citing Images guide: 

http://risd.libguides.com/citingimages 
• Select the Create an Image Caption tab 
• You will see the same image captioned using (1) MLA style and (2) Art Bulletin style 
• Set out, below, the caption for your image, using both styles: 

 
 MLA style     Art Bulletin style 
 
 
 
 
 
 
 
 

Further Information 
The Art Bulletin/CAA’s full standards are at: 
http://www.collegeart.org/artbulletin/guidelines-accepted.html 

See more images captioned using Art Bulletin/CAA’s style 
• Look at CAA’s journal, Art Bulletin (access online via SOLO): 

o Go to SOLO (Oxford’s online catalogue): http://solo.bodleian.ox.ac.uk  
(or type solo bodleian in your browser’s search box) 

o Search for the journal Art Bulletin (restrict your search to Journals, then Online 
Resources) 

o Select Art Bulletin, then View Online 
• You will see that Art Bulletin is available via various platforms: 

o Select the most comprehensive platform (JSTOR) 
o Select a recent issue, then Front matter 

• On or around p. 3 you will see Captions instructions 
o Return to the contents list for the journal issue 
o Select an article, then look at the images to see the captions 

MLA’s full standards 
MLA issued the 8th edition of its style guide in 2016. Its new approach aims for greater simplicity 
and flexibility. It recommends a universal set of guidelines that researchers can apply to any 
source, in any format, in any field. See the Purdue Online Writing Lab for details at: 

• https://owl.english.purdue.edu/owl/resource/747/22/ 

http://risd.libguides.com/citingimages
http://www.collegeart.org/artbulletin/guidelines-accepted.html
http://solo.bodleian.ox.ac.uk/
https://owl.english.purdue.edu/owl/resource/747/22/
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Rights and Permissions 
There are many questions image users ask: 

• Which images can I use for my publication? 
• Who owns the rights?  
• How do I get permission? 
• When don’t I need permission? 
• How can I find cost free images? 
• Can I take a photo myself and include it in a publication? 
• Can I use this image for a poster? What about in a blog? 
• What’s the difference between fair use and fair dealing? 

A variety of sources may help: 
• IAP (Images for Academic Publishing) 
• Creative Commons (rights-defined, licensed images) 
• Public Domain (images not subject to, or no longer under copyright protection)  

But there are no easy answers in the rights arena. Very often you will get the reply  
“it depends…”. 

Tasks 
Find rights free images 
Some institutions allow their images to be used without payment if for an academic publication. 
The source must still be acknowledged. 
Find an IAP (Images for Academic Publishing) image on Artstor 

• Log on to your Artstor account 
• In the search box, type iap hospital 
• Click on the IAP logo beneath the thumbnail you want to download and follow instructions 
• For more information about IAP images on Artstor click on the Help button, then type iap 

in the search box 

Find a Creative Commons image 
• In your browser go to https://search.creativecommons.org/ 
• The Creative Commons platform allows you to search different sources, e.g. Flickr, 

Google, Wikimedia Commons. You can also search for different types of license. 
• Type in your search term(s) (eg bodleian) 
• Check/uncheck the boxes depending in how you want to use the image(s): I want 

something that I can... [for example]: 
o use for commercial purposes 
o modify, adapt, or build upon 

• Select the resource you want to search (e.g. Flickr, YouTube) 
• From your results list double click on an image, then scroll down to see image information 

What kinds of CC licence are available? 
All Creative Commons licenses require attribution to the creator. 
 

Icon Right Description 

 

Attribution  
(CC-BY) 

Licensees may copy, distribute, display and perform the work and 
make derivative works based on it only if they give the author or 
licensor the credits in the manner specified by these. 

https://search.creativecommons.org/
https://en.wikipedia.org/wiki/File:Cc-by_new.svg
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Share-alike  
(CC-SA) 

Licensees may distribute derivative works only under a license 
identical to the license that governs the original work.  

 

Non-commercial 
(CC-NC) 

Licensees may copy, distribute, display, and perform the work and 
make derivative works based on it only for non-commercial purposes. 

 

No Derivative Works 
(CC-ND) 

Licensees may copy, distribute, display and perform only verbatim 
copies of the work, not derivative works based on it. 

Use these Creative Commons licenses to tag your images and inform other users what they 
should and should not do with your own content. 

Find a rights-free image on Google 
Not all images on Google Images are Creative Commons licensed. However, it is possible to limit 
your search results to images available under a Creative Commons license. 

• In your browser go to Google Advanced Image Search: 
https://www.google.co.uk/advanced_image_search 

• Type in your search word(s) 
• Scroll down to the last box to select the kind of licence you want 
• In the drop-down list, change the limit from not filtered by licence to free to use or 

share 
• From your results, double click on an image, then select Visit page 

Scroll down to see the image information 

Further Information 
Where can I find clear information on image rights? 

• Go to the Intellectual Property Office (UK). See: 
Copyright notice: digital images, photographs and the internet: 
https://www.gov.uk/government/publications/copyright-notice-digital-images-
photographs-and-the-internet 

Some other sources of CC images 
There are a number of web sites that have CC image collections: 

• Flickr Creative Commons: http://www.flickr.com/creativecommons/ 
• FlickrCC: http://flickrcc.bluemountains.net/  
• Flickr Storm: http://www.zoo-m.com/flickr-storm/ 
• Wikimedia Commons: http://commons.wikimedia.org/wiki/Main_Page 

See also Harvard’s guide: 
• Finding Public Domain & Creative Commons Media: http://guides.library.harvard.edu/ 

Some sources for Creative Commons video content  
There are also sites which offer CC video collections: 

• Internet Archive Stock Footage: https://archive.org/details/stock_footage 
Footage available under a variety of licenses, including Creative Commons licenses, as well 
as in the public domain.  

• Moving Image Archive: https://archive.org/details/movies 
Part of the Internet Archive. Access to thousands of Creative Commons-licensed videos, 
organized into sub-collections by subject. 

• Vimeo: http://vimeo.com/creativecommons 
Option to both browse content that is Creative Commons-licensed and to limit your search 
results to only Creative Commons-licensed content using advanced filters. 

• WikiMedia Commons Video: http://commons.wikimedia.org/wiki, then select Videos (top 
right). 

https://www.google.co.uk/advanced_image_search
https://www.gov.uk/government/publications/copyright-notice-digital-images-photographs-and-the-internet
https://www.gov.uk/government/publications/copyright-notice-digital-images-photographs-and-the-internet
http://www.flickr.com/creativecommons/
http://flickrcc.bluemountains.net/
http://www.zoo-m.com/flickr-storm/
http://commons.wikimedia.org/wiki/Main_Page
http://guides.library.harvard.edu/
https://archive.org/details/stock_footage
https://archive.org/details/stock_footage
https://archive.org/details/movies
https://archive.org/details/movies
http://vimeo.com/creativecommons
http://vimeo.com/creativecommons
http://commons.wikimedia.org/wiki/Category:Videos
http://commons.wikimedia.org/wiki
https://en.wikipedia.org/wiki/File:Cc-sa.svg
https://en.wikipedia.org/wiki/File:Cc-nc.svg
https://en.wikipedia.org/wiki/File:Cc-nd.svg
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• YouTube: https://www.youtube.com/creativecommons 
Option to browse Creative Commons-licensed content or filter your search results to only 
include Creative Commons-licensed videos. 

Public Domain images 
"A work of authorship is in the “public domain” if it is no longer under copyright protection or if 
it fails to meet the requirements for copyright protection. Works in the public domain may be 
used freely without the permission of the former copyright owner." (Source: copyright.gov)  
Since such works can be used without first seeking permission, they are ideal for many projects, 
particularly those that will extend beyond educational uses. 

Some sources for Public Domain still images 
See Harvard’s guide, Finding Public Domain & Creative Commons Media: 
http://guides.library.harvard.edu/ and the following: 

• Wikipedia’s Public Domain Image Resources: 
http://en.wikipedia.org/wiki/Wikipedia:Public_domain_image_resources 

• Flickr and Flickr's The Commons: http://www.flickr.com/commons/usage/ 
Flickr now includes an option to mark media uploaded to the site as being in the Public 
Domain. Flickr maintains The Commons, which offers access to images with no known 
copyright restrictions from over 70 institutions (eg NASA). Users can limit their image 
searches to a specific institution. 

• Public Domain Review: http://publicdomainreview.org/collections/ 
You can sort by the type of public domain rights that apply to the items – eg, whether an 
image is in the public domain everywhere in the world. 

• Public Domain Pictures: http://publicdomainpictures.net/ 

Fair Use vs Fair Dealing 
What’s the difference between fair use and fair dealing? 
It’s complicated!!! The important thing to remember is that fair dealing (UK) is more restrictive 
than fair use (US). So, just because a web site tells you it’s ok to use an image because fair use 
applies, doesn’t mean that this is applicable in the UK. 
Fair use is applicable in the US (see United States Code – Copyright – Section 107: Fair Use): 

• ‘Section 107 contains a list of the various purposes for which the reproduction of a 
particular work may be considered fair, such as criticism, comment, news reporting, 
teaching, scholarship, and research. Section 107 also sets out four factors to be considered 
in determining whether or not a particular use is fair: 
o The purpose and character of the use, including whether such use is of commercial 

nature or is for non-profit educational purposes. 
o The nature of the copyrighted work. 
o The amount and substantiality of the portion used in relation to the copyrighted work as 

a whole. 
o The effect of the use upon the potential market for, or value of, the copyrighted work’. 

See also: 
• http://copyright.gov/fair-use/more-info.html  
• College Art Association’s Code of Best Practices in Fair Use for the Visual Arts: 

http://www.collegeart.org/fair-use/  
Fair dealing applies in the UK, Canada, etc. The UK’s fair dealing copyright exceptions outline 
specific purposes for which a reproduction of a work is permitted without requiring the copyright 
owner’s permission. There is no copyright infringement if the use amounts to fair dealing for the 
purposes of: 

• non-commercial research or private study 
• criticism or review 
• reporting current events 
• illustration for instruction, quotation, or parody, caricature or pastiche 

https://www.youtube.com/creativecommons
https://www.youtube.com/creativecommons
http://guides.library.harvard.edu/
http://en.wikipedia.org/wiki/Wikipedia:Public_domain_image_resources
http://www.flickr.com/commons/usage/
http://publicdomainreview.org/collections/
http://publicdomainpictures.net/
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This list is exhaustive, which means that it is irrelevant whether or not the use of copyright-
protected work is fair in general, or if it is fair for a purpose not listed in the legislation. 
See also: 

• http://library.leeds.ac.uk/info/138/copyright_and_licences/55/copyright-the_basics/4 
• Intellectual Property Office’s Exceptions to Copyright – Fair Dealing guidance: 

https://www.gov.uk/guidance/exceptions-to-copyright#fair-dealing 
For more information on the differences between Fair Use and Fair Dealing, see: 

• DACS’s guide on the differences between Fair Use and Fair Dealing: 
http://www.dacs.org.uk/latest-news/us-fair-use-uk-fair-dealing-differences-
law?category=For+Artists&title=N 

Check your image is rights free 
• Use copyright guru Tim Padfield’s Copyright flowchart: 

www.bl.uk/reshelp/pdfs/copyrightflowchart.pdf (document will download to your 
desktop). 

• Find copyright holders via WATCH (Writers Artists and their Copyright Holders, (University 
of Reading & UT Austin): http://norman.hrc.utexas.edu/watch. Warning!!!! - WATCH can 
be a useful starting point but it is by no means fully comprehensive. 

Publishing images 
Regardless of where you source your digital image content, keep a record of where and when 
you have accessed/downloaded this content, just as you would for text resources. You may need 
to revisit this information if the purpose of your image use changes – e.g. if you decide you want 
to publish image content that had previously used for a presentation. 

Doctoral theses and images 
The same applies to images in your doctoral thesis. When you submit it to ORA (the University’s 
Research Archive) it will be ‘published’ online.  
For extensive guidelines governing the inclusion of third party content, including images in your 
thesis, see the ORA website: 

• http://www.bodleian.ox.ac.uk/ora/oxford_etheses , then Theses: Copyright and other 
legal issues 

Need help with a publication & image rights and don’t have time for DIY?  
The image research agency Art Resource (New York), long used by art historians, will do all the 
work for you (for a fee): www.artres.com. Still AND moving images. 

Where else can I get advice? 
Local copyright advice from the Bodleian Libraries: copyright@bodleian.ox.ac.uk 

http://norman.hrc.utexas.edu/watch
mailto:copyright@bodleian.ox.ac.uk
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Lynda.com 
Managing and adapting still and moving images involves a number of technical skills. If you have 
a need to develop some of these skills you should explore the courses that are on offer through 
the IT Learning Programme run by IT Services (http://courses.it.ox.ac.uk) and the iSkills sessions 
given by the Bodleian Libraries (http://libguides.bodleian.ox.ac.uk/workshops). 
If you prefer to learn through video-based, on-line activities, you should make use of the 
University’s subscription to Lynda.com. 
Lynda.com is a collection of over 5,000 online training sessions/courses that are free to access 
by all University members.  

Task 
Explore the courses that are offered through Lynda.com 

• Open a browser window 
• Visit http://courses.ox.ac.uk/lynda 
• Click on the Access Lynda.com button. 
• If you are not already signed in you will be prompted to give your Single Sign On (SSO) 

credentials. 
• The first time you visit Lynda.com you will be asked some basic ‘profile’ questions. These 

are optional and you can leave them blank if you prefer. Any email address you give is NOT 
shared by Lynda.com with any other organisation, and is used only by the Lynda.com 
course platform. 

• You can search Lynda.com using keywords. Explore what’s available for some of the 
common tools that you might use with your images, for example: 
o PowerPoint 
o Photoshop 
o GIMP 
o Handbrake 
o Windows Media Player 
o iMovie 

 

http://courses.it.ox.ac.uk/
http://libguides.bodleian.ox.ac.uk/workshops
http://courses.ox.ac.uk/lynda
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Your Notes 
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	Image Subscription Databases
	Task
	Find images
	 Open a browser, and go to SOLO (Oxford’s online catalogue): http://solo.bodleian.ox.ac.uk (or type solo bodleian in the Search box)
	 In the SOLO Search box, type one of the following database names
	 From the SOLO results list, click View Online below the database’s name
	o Archivision: No need to login or register
	o Artstor: You MUST register if you want to use the images you find (Register button is top right)
	o Bridgeman Education: No need to login or register. DO NOT TRY TO SEARCH the Bridgeman (as opposed to Bridgeman Education) database; this is not for educational use and we do not have access to it.
	Search all three databases to compare content
	 Use keyword(s) to search your own topic OR try searching a cultural icon (eg maria callas) OR a text (eg macbeth) OR a location (eg delhi) OR an event (eg french revolution) OR a concept (eg discrimination).
	View a larger image:
	 Double-click on a thumbnail
	 Zoom an image (Artstor and Bridgeman Education only):
	o Artstor: Click on “+” / “ –“ to ZOOM/zoom out (or use the  icon)
	o Bridgeman Education: Click on the eye symbol () to ZOOM (or use “+” / “ –“ buttons)
	Compare image information
	 Archivision: From the opened image (not the thumbnail), select Go to Record
	 ARTstor and Bridgeman Education: Click on the text below the thumbnail.
	 Textual data can range from brief to extremely long and informative. Most data should provide:
	o Image ID number
	o Copyright holder. You cannot publish the image without first contacting the copyright holder.
	Save ONE image to your desktop or memory stick
	 Archivision: Right click on the image, then select Save Image As
	 ARTstor: Double-click on the image, then click on the  icon & follow instructions. You must be logged on to do this.
	 Bridgeman Education: Click on the icon below the thumbnail. Then click on the Save drop-down menu (bottom of the screen), then select Save As
	Save several images
	 Archivision: Not currently available
	 ARTstor: Save several images to an Image Group
	o Click on several thumbnails (borders will change colour)
	o Select the Organize tab
	o From the drop-down window, choose Save selected images to, then New image group
	o Save in My Work Folder and give the image group a name
	 Bridgeman Education: Save several images to a Slideshow
	o Click on the Select box below each thumbnail you want to save
	o Select Create slideshow (right), then From selected assets, then name your slideshow
	o If you want to make your Slideshow private:
	o Unclick the Make public box and type in your email address
	o Hit the Save button
	Download an image set
	 Archivision: Not currently available
	 ARTstor:
	o Select the Organize tab, then Open image group
	o Select Open My Work Folder, then the image group you are working with
	o Select the Tools tab
	o Select Export image group to PowerPoint
	 Bridgeman Education:
	o Select the relevant Slideshow, then Download. Your Slideshow will download as a PDF document.
	Need more HELP?
	 Archivision: Select the Help button (top right): very detailed instructions
	 ARTstor: Use the Help button: very detailed instructions
	 Bridgeman Education: Select the Using the site tab
	Need more resources?
	 Open a browser and go to Oxford’s research guides (“libguides”): http://ox.libguides.com
	 Click on the Subjects A-Z icon, then select Art and Architecture
	 Select the Training tab for links to other sites and documents
	 Select the Images tab for other databases recommended by Oxford researchers
	Rights and Permissions Information for Images in Archivision, ARTstor and Bridgeman Education
	 it is for a presentation or a paper/ essay
	 you are NOT planning to publish it
	Archivision
	ARTstor
	Bridgeman Education
	Other Reliable Image Sources
	Task
	Search for an image in Flickr, Wellcome Images, and NYPL Digital Collections.
	 Open three web browser tabs:
	o Flickr: http://flickr.com: Search for aspirin
	o Wellcome Images: http://wellcomeimages.org/: Search for aspirin
	o NYPL Digital Collections: http://digitalcollections.nypl.org/ : Search for aspirin
	 Select an image and examine the corresponding information
	o Flickr
	o On the search results page, select an image
	o View information: Scroll down to view photographer’s details, image rights, and some data about the photograph (EXIF data).
	o View other images by the same photographer: Click on photographer’s name
	o Wellcome
	o On the search results page, select an image
	o Scroll down to view the image details, credits and the copyright notice
	o NYPL
	o  On the search results page, select the image
	o  View further information: Select More details
	Download an image and obtain the image URL for sharing
	 Flickr:
	o On the search results page, select an image
	o Select  (lower right hand side of the image) Note:  Some images ask you to create/sign into a Flickr account (using Yahoo) before you can download.
	o Select  (lower right hand side of the image)
	o Highlight the URL, then press Ctrl+C to copy the link Note: You can share the image via Facebook, Tumblr, Twitter, Pinterest
	 Wellcome Images:
	o On the search results page, select an image
	o EITHER Download a low-res image; OR Email; OR Print; OR Download hi-res image OR Add to Lightbox Note: You may find an image designated as a Rights-managed image. If you want to download the high-res version of one of these images, you will be need ...
	 NYPL Digital Collections:
	o On the search results page, select an image
	o Below the image (right hand side), hover over the box next to the PERMALINK and Click to copy. (If necessary: In the pop-up box, select Allow now.)
	o View the Download options. (You can also order a high-resolution file if you wish.)
	o Select the 760px image and follow your browser’s instructions to open or save the image. Save the image to your desktop.
	Further reliable image sources
	 Museums/galleries/museums/libraries/archives
	o Usually best to go direct to source
	o Many will allow downloading of low resolution images for private study and often teaching
	o If you want to publish an image from a museum, etc.:
	o Always refer to the institution’s Terms and Conditions (“T’s & C’s”) to be sure what you can and what you cannot do with downloaded content
	o Some may re-direct you to a third party.
	o Some may allow you to download higher resolution images for academic publishing (“IAP”), e.g.: the Metropolitan Museum of Art (New York); the Getty Research Institute (Los Angeles) via its Open Content Program [this is NOT the same as Getty Images];...
	 Use Oxford information resources relating to image research
	o Open a browser and go to Oxford’s research guides (“libguides”): http://ox.libguides.com
	o Click on the Subjects A-Z icon, then select Art and Architecture
	o Select the Training tab for links to other sites and documents
	 OR Select the Images tab for other image databases recommended by Oxford researchers
	Using Video
	Task
	Embed a video link into a presentation
	 Open PowerPoint and create a new presentation In the Home tab of the ribbon, select New Slide, then Layout, then Blank
	 Open a browser and go to YouTube: www.youtube.com
	 In YouTube’s search box, type piranesi carceri cini
	 Select the version uploaded by the Fondazione Giorgio Cini video (also with the highest number of hits - 20-30,000 – should come at the top of your results list)
	 Below the video, click Share, then (below) Embed
	 Copy the Embed code in the box below
	 Select PowerPoint’s Insert tab, then Video, then Online video (or Video from Web Site)
	 Paste the Embed code into the Video Embed Code box that appears on the slide
	 Press F5 to display the slide, click on the video box, click Watch on YouTube to run video
	Embed a video into a presentation
	 Open PowerPoint and create a new presentation In the Home tab of the ribbon, select New Slide, then Layout, then Blank
	 In the Insert tab of the ribbon, select Video | Video on my PC (or Video from File)
	 Select a video you’ve saved previously, then click Insert
	 Press F5 to display the slide, and click on the video to play it
	Trim an embedded video
	 In PowerPoint select/create your presentation
	 Click on the video you’ve embedded to select it
	 In the Playback tab, select Trim Video
	 Drag the green and red (Start and Finish) sliders to define an extract of the video, then click OK
	 Press F5 to display the slide, and click on the video to play it
	 In Normal view, on the video frame, press Play.
	 Select the video on the slide.
	 Under Video Tools, on the Playback tab, in the Editing group, click Trim Video.
	 In the Trim Video dialog box, do one or more of the following:
	o To trim the beginning of the clip, click the start point (shown in the image below as a green marker, on the far left). When you see the two-headed arrow, drag the arrow to the desired starting position for the video.
	o To trim the end of the clip, click the end point (shown in the image below as a red marker, on the right). When you see the two-headed arrow, drag the arrow to the desired ending position for the video.
	Capture a still from a video
	 In PowerPoint select/create your presentation In the Home tab of the ribbon, select New Slide, then Layout, then Blank.
	 Minimise PowerPoint.
	 Open a browser and go to http://www.youtube.com or http://vimeo.com.
	 Select a video and play it.
	 Pause the video at a point of your choosing (lower left-hand button).
	 Use Alt+Tab button to return to PowerPoint.
	 In the Insert tab of the ribbon, click on Screenshot, then select Screen Clipping. The browser window (with your paused video) will reappear, and the cursor changes to a crosshair.
	 Click and drag the crosshair over the area of the video that you want to capture. PowerPoint will automatically grab the area and insert it into the slide.
	Further Information
	Video formats
	Potential problems
	Copyright
	Reverse Image Searching
	Task
	Match your image
	 Open a browser, then go to TinEye Reverse Image Search: http://tineye.com/
	 In the Search box you will see Upload or Enter Image URL
	 Next to the search box (left), click on
	 On the desktop, go to the  folder for this training session, then select TinEyeExample.jpg
	 From the drop-down Sort by box, select Best match
	Find out about the image content
	 Click on the Page link next to the image.
	Can you answer the following?
	 Q: What’s in the image? A:
	 Q: Where is it? A:
	 Q: Who designed it? A:
	 Q: Who owns the rights? A:
	Image Anatomy
	Task
	Open XnView MP
	 Start XnView  from the XnView MP shortcut.
	 Maximise the XnView window.
	 In the Folders panel at the left of the XnView window, browse to the folder containing the session files.
	Examine the original image
	 Use View | View As | Thumbnails + Labels to show the image thumbnails.
	 Single click on the image of the bronze horse’s head to select it.
	 In the Info panel (bottom left), note the format is TIFF and the size is about 19MB.
	 Double-click on the image in the Preview panel to the right of the Info panel.
	 Use View | Zoom | 1600% to clearly see the pixels in the image.
	 Close the Preview tab to return to the Browser tab
	Export the image in a JPEG format
	 Use Tools | Export to display the Export dialog.
	 By default the JPEG export option is shown. Put a tick in the Auto refresh tick box.
	 Drag the Quality slider along the scale and notice the change in file size between the best and the lowest quality.
	 Use the Zoom button to zoom in and compare the original (left) with the preview.
	 At what quality setting can you discern differences between the original and the preview?
	 Set the Quality slider to 80 and click Export. Give the file the name Quality80.
	 Select the original, and repeat the Export, but this time use a Quality setting of 5, using a file name of Quality5.
	 Compare the file sizes and ‘look’ of the images by double-clicking on them.
	Close the program
	 Use File | Quit to close XnView.
	Answer the following question:
	 Why would you want to save a TIFF image as a low quality JPEG image?
	Further Information
	Images and pixels
	Images and colour
	Compression
	Vector images
	Resizing Images
	Task
	Insert an image into a Word document
	 Open Word
	 Create a new, blank document.
	 Use Insert | Picture and select the HorseBronze image from the session file folder. This is a bitmap image (as a TIFF format) which has enough pixels (and hence detail) to fill the width of the page at high quality. TIFF is a lossless format, which ...
	Save the document and examine its properties
	 Use File | Save to save the document with the name original.docx.
	 Use File | Info to examine the properties of the document. In particular look at the Size of the document. It should be about 3.5 MB. Can you explain where the other 15.4 MB has gone?
	 Click on Close to close the document.
	Reduce the image size and resave the document
	 Re-open the original.docx document
	 Click on the image to select it.
	 In the Format tab of the Ribbon, in the Size group, change the Height to 2cm. The width will also change.
	 Use File | Save As to save the document with the name reduced.docx.
	 Use File | Info to examine the properties of the document. In particular look at the Size of the document. It should be about 130 KB. Can you explain this?
	 Click on Close to close the document.
	Enlarge the image and resave the document
	 Re-open the reduced.docx document
	 Click on the image to select it.
	 In the Format tab of the Ribbon, in the Size group, change the Height back to 12cm. The width will also change.
	 Notice the degradation of the detail in the image. Why has this happened?
	 Use File | Save As to save the document with the name enlarged.docx. The file size should be about 130 KB. Why has this number not changed from the ‘reduced’ file?
	 Click on Close to close the document.
	Further Information
	Images and pixels
	Displaying images at their natural size
	Displaying images at a smaller size
	Displaying images at a larger size
	Viewing and Organising Image Metadata
	Task
	 Start XnView  from the XnView MP folder.
	 Maximise the XnView window.
	 In the Folders panel at the left of the XnView window, browse to the folder containing the session files, OR select any image/s that you have saved previously.
	 Examine the metadata for some images
	o Use View | View As | Thumbnails & Labels to show the image thumbnails with some of their metadata.
	o Single-click on an image to select it. (Image appears in lower panel of the screen, in Preview mode.)
	o The Info panel (bottom left of the XnView window) and Preview panel (bottom right) will be updated.
	o In the Info panel, click on the Properties and the ExifTool tabs to investigate the kind of information for the image.
	o The ExifTool information can sometimes take a while to update itself. Some image types have little or no Exif data.
	o The Categories tab will show boxes listing image contents type. Select the boxes relevant to your image.
	 Examine some other images as above.
	 Use File | Quit to close XnView.
	 Start Adobe Bridge from the Adobe Bridge folder.
	 Maximise the Adobe Bridge window.
	 In the Folders panel at the left of the Adobe Bridge window, browse to the folder containing the session files, OR select any image/s that you have saved previously.
	 Examine and edit the metadata for some images.
	o Use View | As Thumbnails to show the image thumbnails with some of the metadata.
	o Single click on an image to select it. (Image appears in the Preview panel, right-hand side of the window.)
	o In the Preview panel select the dropdown arrows next to IPTC core and the Camera Data (Exif). View tagging options available.
	o Some image types have little or no IPTC or Exif data.
	 Add relevant data, for example to the Creator or Keyword fields; you will be prompted to Apply your updates to the metadata.
	 In the Search box (top right) enter a tag term you applied to your image/s; the image(s) with this tag in the metadata will appear in the Contents panel.
	 Use File | Exit to close Adobe Bridge.
	Further Information
	Managing image metadata across different software packages.
	Image metadata convertors and editors
	Backing Up Your Images
	Task
	Further Information
	Backup of your image collections
	An image ingestion workflow
	Archive of your image collection
	Citing and Captioning Images
	Task
	Caption an image
	 Select an image you’ve previously found
	 Go to the Rhode Island School of Design (RISD) Citing Images guide: http://risd.libguides.com/citingimages
	 Select the Create an Image Caption tab
	 You will see the same image captioned using (1) MLA style and (2) Art Bulletin style
	 Set out, below, the caption for your image, using both styles:
	Further Information
	See more images captioned using Art Bulletin/CAA’s style
	 Look at CAA’s journal, Art Bulletin (access online via SOLO):
	o Go to SOLO (Oxford’s online catalogue): http://solo.bodleian.ox.ac.uk  (or type solo bodleian in your browser’s search box)
	o Search for the journal Art Bulletin (restrict your search to Journals, then Online Resources)
	o Select Art Bulletin, then View Online
	 You will see that Art Bulletin is available via various platforms:
	o Select the most comprehensive platform (JSTOR)
	o Select a recent issue, then Front matter
	 On or around p. 3 you will see Captions instructions
	o Return to the contents list for the journal issue
	o Select an article, then look at the images to see the captions
	MLA’s full standards
	 https://owl.english.purdue.edu/owl/resource/747/22/
	Rights and Permissions
	Tasks
	Find rights free images
	 Log on to your Artstor account
	 In the search box, type iap hospital
	 Click on the IAP logo beneath the thumbnail you want to download and follow instructions
	 For more information about IAP images on Artstor click on the Help button, then type iap in the search box
	Find a Creative Commons image
	 In your browser go to https://search.creativecommons.org/
	 The Creative Commons platform allows you to search different sources, e.g. Flickr, Google, Wikimedia Commons. You can also search for different types of license.
	 Type in your search term(s) (eg bodleian)
	 Check/uncheck the boxes depending in how you want to use the image(s): I want something that I can... [for example]:
	o use for commercial purposes
	o modify, adapt, or build upon
	 Select the resource you want to search (e.g. Flickr, YouTube)
	 From your results list double click on an image, then scroll down to see image information
	What kinds of CC licence are available?
	Find a rights-free image on Google
	 In your browser go to Google Advanced Image Search: https://www.google.co.uk/advanced_image_search
	 Type in your search word(s)
	 Scroll down to the last box to select the kind of licence you want
	 In the drop-down list, change the limit from not filtered by licence to free to use or share
	 From your results, double click on an image, then select Visit page Scroll down to see the image information
	Further Information
	Where can I find clear information on image rights?
	 Go to the Intellectual Property Office (UK). See: Copyright notice: digital images, photographs and the internet: https://www.gov.uk/government/publications/copyright-notice-digital-images-photographs-and-the-internet
	Some other sources of CC images
	 Flickr Creative Commons: http://www.flickr.com/creativecommons/
	 FlickrCC: http://flickrcc.bluemountains.net/
	 Flickr Storm: http://www.zoo-m.com/flickr-storm/
	 Wikimedia Commons: http://commons.wikimedia.org/wiki/Main_Page
	 Finding Public Domain & Creative Commons Media: http://guides.library.harvard.edu/
	Some sources for Creative Commons video content
	 Internet Archive Stock Footage: https://archive.org/details/stock_footage Footage available under a variety of licenses, including Creative Commons licenses, as well as in the public domain.
	 Moving Image Archive: https://archive.org/details/movies Part of the Internet Archive. Access to thousands of Creative Commons-licensed videos, organized into sub-collections by subject.
	 Vimeo: http://vimeo.com/creativecommons Option to both browse content that is Creative Commons-licensed and to limit your search results to only Creative Commons-licensed content using advanced filters.
	 WikiMedia Commons Video: http://commons.wikimedia.org/wiki, then select Videos (top right).
	 YouTube: https://www.youtube.com/creativecommons Option to browse Creative Commons-licensed content or filter your search results to only include Creative Commons-licensed videos.
	Public Domain images
	Some sources for Public Domain still images
	 Wikipedia’s Public Domain Image Resources: http://en.wikipedia.org/wiki/Wikipedia:Public_domain_image_resources
	 Flickr and Flickr's The Commons: http://www.flickr.com/commons/usage/ Flickr now includes an option to mark media uploaded to the site as being in the Public Domain. Flickr maintains The Commons, which offers access to images with no known copyright...
	 Public Domain Review: http://publicdomainreview.org/collections/ You can sort by the type of public domain rights that apply to the items – eg, whether an image is in the public domain everywhere in the world.
	 Public Domain Pictures: http://publicdomainpictures.net/
	Fair Use vs Fair Dealing
	 ‘Section 107 contains a list of the various purposes for which the reproduction of a particular work may be considered fair, such as criticism, comment, news reporting, teaching, scholarship, and research. Section 107 also sets out four factors to b...
	o The purpose and character of the use, including whether such use is of commercial nature or is for non-profit educational purposes.
	o The nature of the copyrighted work.
	o The amount and substantiality of the portion used in relation to the copyrighted work as a whole.
	o The effect of the use upon the potential market for, or value of, the copyrighted work’.
	 http://copyright.gov/fair-use/more-info.html
	 College Art Association’s Code of Best Practices in Fair Use for the Visual Arts: http://www.collegeart.org/fair-use/
	 non-commercial research or private study
	 criticism or review
	 reporting current events
	 illustration for instruction, quotation, or parody, caricature or pastiche
	 http://library.leeds.ac.uk/info/138/copyright_and_licences/55/copyright-the_basics/4
	 Intellectual Property Office’s Exceptions to Copyright – Fair Dealing guidance: https://www.gov.uk/guidance/exceptions-to-copyright#fair-dealing
	 DACS’s guide on the differences between Fair Use and Fair Dealing: http://www.dacs.org.uk/latest-news/us-fair-use-uk-fair-dealing-differences-law?category=For+Artists&title=N
	Check your image is rights free
	 Use copyright guru Tim Padfield’s Copyright flowchart: www.bl.uk/reshelp/pdfs/copyrightflowchart.pdf (document will download to your desktop).
	 Find copyright holders via WATCH (Writers Artists and their Copyright Holders, (University of Reading & UT Austin): http://norman.hrc.utexas.edu/watch. Warning!!!! - WATCH can be a useful starting point but it is by no means fully comprehensive.
	Publishing images
	Doctoral theses and images
	 http://www.bodleian.ox.ac.uk/ora/oxford_etheses , then Theses: Copyright and other legal issues
	Need help with a publication & image rights and don’t have time for DIY?
	Where else can I get advice?
	Lynda.com
	Task
	 Open a browser window
	 Visit http://courses.ox.ac.uk/lynda
	 Click on the Access Lynda.com button.
	 If you are not already signed in you will be prompted to give your Single Sign On (SSO) credentials.
	 The first time you visit Lynda.com you will be asked some basic ‘profile’ questions. These are optional and you can leave them blank if you prefer. Any email address you give is NOT shared by Lynda.com with any other organisation, and is used only b...
	 You can search Lynda.com using keywords. Explore what’s available for some of the common tools that you might use with your images, for example:
	o PowerPoint
	o Photoshop
	o GIMP
	o Handbrake
	o Windows Media Player
	o iMovie
	Your Notes

